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Deciding on whether to read the SnapCenter Data
Protection Guide for Custom Plug-ins
This information describes how to use SnapCenter to perform backup, restore, and clone operations
on resources such as databases, instances, documents, or tablespaces.
You should read this information if you want to use SnapCenter in the following ways:
•

You want to create data protection policies and resource groups for custom plug-in resources

•

You want to perform backup, restore, or clone operations on custom plug-in resources using the
graphical user interface (GUI)

•

You want to perform backup, restore, or clone operations on custom plug-in resources using
Windows cmdlets or CLI commands

You should have already performed the following tasks:
•

Installed SnapCenter Server and the SnapCenter custom plug-in

•

Configured role-based access control (RBAC), storage system connections, and credentials

You can also use the following information to help accomplish your data protection goals:
•

SnapCenter Server and plug-in installation and setup

Installing and setting up SnapCenter
Getting Started
•

SnapCenter concepts, including architecture, features, and benefits

Concepts
•

Other SnapCenter Data Protection Guides for specific types of resources, such as Microsoft SQL
Server, Oracle, Windows file systems, and custom plug-ins

•

SnapCenter PowerShell cmdlets or Linux commands

SnapCenter Software 4.2 Windows Cmdlet Reference Guide
SnapCenter Software 4.2 Linux Command Reference Guide
•

SnapCenter administration, including dashboards, reporting capabilities, and REST APIs, and
managing licenses, storage connections, and the SnapCenter Server repository

Performing administrative tasks
•

SnapCenter developer information for custom plug-ins
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SnapCenter Custom Plug-ins overview
You can develop custom plug-ins for applications that you use and then use SnapCenter to backup,
restore, or clone these applications. Like other SnapCenter plug-ins, your custom plug-ins act as hostside components of the NetApp SnapCenter Software, enabling application-aware data protection and
management of resources.
When Custom Plug-ins are installed, you can use SnapCenter with NetApp SnapMirror technology to
create mirror copies of backup sets on another volume and use NetApp SnapVault technology to
perform disk-to-disk backup replication. The Custom Plug-ins can be used in both Windows and
Linux environments.
NetApp provides MySQL and DB2 custom plug-ins with SnapCenter Software 2.0 and later and
MongoDB custom plug-in from 3.0 and later. These plug-ins can be downloaded from the NetApp
Storage Automation Store.
Note: MySQL, DB2, and MongoDB custom plug-ins are supported via the NetApp communities

only.
You can create your own custom plug-ins by referring to the Developer's Guide for Creating Custom
Plug-ins.
The Data Protection Guide for your plug-in has information about data protection operations.
The SnapCenter concepts documentation has information about the SnapCenter architecture,
features, and benefits.
Related information

Installing and setting up SnapCenter
SnapCenter Software 4.2 Developer's Guide for Creating Custom Plug-ins
Concepts
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Data protection workflow for SnapCenter Custom
Plug-ins resources
The data protection workflow lists the tasks that you have to perform for data protection.

Related tasks

Backing up custom plug-in resources on page 12
Restoring custom plug-in resources on page 27
Cloning custom plug-in resource backups on page 31
Related information

Installing and setting up SnapCenter
Concepts
Performing administrative tasks
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Preparing for data protection
Before performing any data protection operation such as backup, clone, or restore operations, you
must define your strategy and set up the environment. You can also set up the SnapCenter Server to
use SnapMirror and SnapVault technology.
To take advantage of SnapVault and SnapMirror technology, you must configure and initialize a data
protection relationship between the source and destination volumes on the storage device. You can
use NetApp System Manager or you can use the storage console command line to perform these
tasks.
Related information

Installing and setting up SnapCenter

Prerequisites for using the SnapCenter Custom Plug-ins
Before you use SnapCenter Custom Plug-ins, the SnapCenter administrator must install and
configure the SnapCenter Server and perform the prerequisite tasks.
•

Install and configure SnapCenter Server.

•

Log in to SnapCenter Server.

•

Configure the SnapCenter environment by adding storage system connections and creating
credentials, if applicable.

•

Add hosts, and install and upload the plug-ins.

•

If applicable, install Java 1.7 or Java 1.8 on your Linux Windows host.

•

If you have multiple data paths (LIFs) or a dNFS configuration, you can perform the following
using the SnapCenter CLI on the database host:
◦

By default, all the IP addresses of the database host are added to the NFS storage export
policy in storage virtual machine (SVM) for the cloned volumes. If you want to have a
specific IP address or restrict to a subset of the IP addresses, run the SetPreferredHostIPsInStorageExportPolicy CLI.

◦

If you have multiple data paths (LIFs) in SVMs, SnapCenter chooses the appropriate data path
(LIF) for mounting the NFS cloned volume. However, if you want to specify a specific data
path (LIF), you must run the Set-SvmPreferredDataPath CLI.

The information regarding the parameters that can be used with the command and their
descriptions can be obtained by running help command_name. Alternatively, you can also refer
to the Command Reference Guide.

SnapCenter Software 4.2 Linux Command Reference Guide
•

Set up SnapMirror and SnapVault, if you want backup replication.

•

Ensure that port 9090 is not used by any other application on the host.
Port 9090 must be reserved for use by SnapCenter Custom Plug-ins in addition to the other ports
required by SnapCenter.

Related information

Installing and setting up SnapCenter
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Storage types supported by SnapCenter Custom Plug-ins
SnapCenter supports a wide range of storage types on both physical and virtual machines. You must
verify the support for your storage type before installing SnapCenter Custom Plug-ins.
Provisioning using SnapCenter is supported on Windows using SnapCenter Plug-in for Microsoft
Windows. Provisioning is not supported for SnapCenter Plug-ins Package for Linux.
Machine

Storage type

Physical and virtual servers
(VMDKs and RDM LUNs are not
supported.)

FC-connected LUNs
iSCSI-connected LUNs
NFS-connected volumes

How resources, resource groups, and policies are used for
protecting custom plug-in resources
Before you use SnapCenter, it is helpful to understand basic concepts related to the backup, clone,
and restore operations you want to perform. You interact with resources, resource groups, and
policies for different operations.
•

Resources are typically databases, Windows file systems, or VMs that you back up or clone with
SnapCenter.

•

A SnapCenter resource group, is a collection of resources on a host or cluster.
When you perform an operation on a resource group, you perform that operation on the resources
defined in the resource group according to the schedule you specify for the resource group.
You can back up on demand a single resource or a resource group. You also can perform
scheduled backups for single resources and resource groups.

•

The policies specify the backup frequency, copy retention, replication, scripts, and other
characteristics of data protection operations.
When you create a resource group, you select one or more policies for that group. You can also
select a policy when you perform a backup on demand for a single resource.

Think of a resource group as defining what you want to protect and when you want to protect it in
terms of day and time. Think of a policy as defining how you want to protect it. If you are backing up
all databases or backing up all file systems of a host, for example, you might create a resource group
that includes all the databases or all the file systems in the host. You could then attach two policies to
the resource group: a daily policy and an hourly policy. When you create the resource group and
attach the policies, you might configure the resource group to perform a File-Based backup daily and
another schedule that performs Snapshot based backup hourly.
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Logging in to SnapCenter
SnapCenter supports role-based access control (RBAC). SnapCenter admin assigns roles and
resources through SnapCenter RBAC to either a user in workgroup or active directory, or to groups in
active directory. The RBAC user can now log in to SnapCenter with the assigned roles.
Before you begin

•

You should enable Windows Process Activation Service (WAS) in Windows Server Manager.

•

If you want to use Internet Explorer as the browser to log in to the SnapCenter Server, you should
ensure that the Protected Mode in Internet Explorer is disabled.

About this task

During installation, the SnapCenter Server Install wizard creates a shortcut and places it on the
desktop and in the Start menu of the host where SnapCenter is installed. Additionally, at the end of
the installation, the Install wizard displays the SnapCenter URL based on the information that you
provided during installation, which you can copy if you want to log in from a remote system.
Attention: If you have multiple tabs open in your web browser, closing just the SnapCenter

browser tab does not log you out of SnapCenter. To end your connection with SnapCenter, you
must log out of SnapCenter either by clicking the Sign out button, or by closing the entire web
browser.
Best Practice: For security reasons, it is recommended that you do not enable your browser to

save your SnapCenter password.
The default GUI URL is a secure connection to the default port 8146 on the server where the
SnapCenter Server is installed (https://server:8146). If you provided a different server port
during the SnapCenter installation, that port is used instead.
For Network Load Balance (NLB) deployment, you must access SnapCenter using the NLB cluster
IP (https://NLB_Cluster_IP:8146). If you do not see the SnapCenter UI when you navigate to
https://NLB_Cluster_IP:8146 in Internet Explorer (IE), you must add the NLB IP address as a
trusted site in IE on each plug-in host, or you must disable IE Enhanced Security on each plug-in
host.

NetApp KB Article 2025082: SnapCenter in an HA configuration with Application Request Routing
enabled.
In addition to using the SnapCenter GUI, you can use PowerShell cmdlets to create scripts to perform
configuration, backup, and restore operations. Some cmdlets might have changed with each
SnapCenter release. The SnapCenter cmdlet or SnapCenter CLI documentation has the details.
Note: If you are logging in to SnapCenter for the first time, you must log in using the credentials
that you provided during the install process.
Steps

1. Launch SnapCenter from the shortcut located on your local host desktop, or from the URL
provided at the end of the installation, or from the URL provided by your SnapCenter
administrator.
2. Enter user credentials.

Logging in to SnapCenter | 11

To specify the following...

Use one of these formats...

Domain administrator

NetBIOS\UserName
UserName@UPN suffix

For example, username@netapp.com
Domain FQDN\UserName

Local administrator

UserName

3. If you are assigned more than one role, from the Role box, select the role that you want to use for
this login session.
Your current user and associated role are shown in the upper right of SnapCenter after you are
logged in.
Result

If you are using SnapCenter for the first time, the Storage Systems page is displayed, and the Get
Started pane is expanded.
If the logging fails with the error that site cannot be reached, you should map the SSL certificate to
SnapCenter.
After logging to SnapCenter Server for the first time, the SnapCenter Server Configuration Checker
schedule is created. The default values are Weekly and Every Sunday at 11:59 pm. To modify the
schedule or run the SnapCenter Server schedule, click Settings > Scheduled Configuration
Checker.
After you finish

If you have untrusted Active Directory domains that you want SnapCenter to support, you must
register those domains with SnapCenter before configuring the roles for the users on untrusted
domains. The administration documentation has more details.

Performing administrative tasks
Related information

SnapCenter Software 4.2 Linux Command Reference Guide
SnapCenter Software 4.2 Windows Cmdlet Reference Guide
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Backing up custom plug-in resources
The backup workflow includes planning, identifying the resources for backup, managing backup
policies, creating resource groups and attaching policies, creating backups, and monitoring the
operations.
About this task

The following workflow shows the sequence in which you must perform the backup operation:

You can also use PowerShell cmdlets manually or in scripts to perform backup, restore, and clone
operations. For detailed information about PowerShell cmdlets, use the SnapCenter cmdlet help or
see the cmdlet reference information.
Related references

Data protection workflow for SnapCenter Custom Plug-ins resources on page 7
Related information

SnapCenter Software 4.2 Windows Cmdlet Reference Guide
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Adding resources to SnapCenter Custom Plug-ins
You must add the resources that you want to back up or clone. Depending on your environment,
resources might be either database instances or collections that you want to back up or clone.
Before you begin

•

You must have completed tasks such as installing the SnapCenter Server, adding hosts, creating
storage system connections, and adding credentials.

•

You must have created a custom plug-in.

Developer Guide for Creating Custom Plug-ins
•

You must have uploaded the plug-ins to SnapCenter Server.

About this task

You can also add resources for MySQL and DB2 applications. These plug-ins can be downloaded
from the NetApp Storage Automation Store.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, click Add Resource.
3. In the Provide Resource Details page, perform the following actions:
For this field...

Do this...

Name

Enter the name of the resource.

Host name

Select the host.

Type

Select the type.
Type is user defined as per the plug-in description file. For example,
database and instance.
In case the type selected has a parent, enter the details of the parent.
For example, if the type is Database and the parent is Instance, enter
the details of the Instance.

Credential name

(Optional) Select Credential or create a new credential.

Mount Points

Enter the mount paths where the resource is mounted.
This is applicable only for a Windows host.
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4. In the Provide Storage Footprint page, select a storage system and choose one or more volumes,
LUNs, and qtrees, and then click Save.
Optional: Click the
systems.

icon to add more volumes, LUNs, and qtrees from other storage

Note: SnapCenter Custom Plug-ins does not support automatic discovery of the resources and
the storage details for physical and virtual environments. You must provide the storage
information for physical and virtual environments while creating the resources.

5. In the Resource Settings page, provide custom key-value pairs for the resource.
Use the custom key-value pairs if you want to pass resource-specific information. For example,
when you are using the MySQL plug-in, you must specify a HOST as HOST=hostname, Port
=port-no used for MySQL and master-slave configuration as MASTER_SLAVE = “YES” or
“NO” (name is MASTER_SLAVE and value is “YES” or “NO”).

Backing up custom plug-in resources | 15

6. Review the summary, and then click Finish.
Result

The resources are displayed along with information such as type, host or cluster name, associated
resource groups and policies, and overall status.
After you finish

If you want to provide access to the assets to other users, the SnapCenter administrator must assign
assets to those users. This enables users to perform the actions for which they have permissions on
the assets that are assigned to them.
After adding the resources, you can modify the resource details. If a custom plug-in resource has
backups associated with it, the following fields cannot be modified: resource name, resource type,
and host name.

Creating policies for custom plug-in resources
Before you use SnapCenter to back up custom plug-in specific resources, you must create a backup
policy for the resource or resource group that you want to back up. A backup policy is a set of rules
that governs how you manage, schedule, and retain backups. Additionally, you can specify
replication, script, and application settings. Specifying options in a policy saves time when you want
to reuse the policy for another resource group.
Before you begin

•

You must have defined your backup strategy.
For details, see the information about defining a data protection strategy for custom plug-ins.

Concepts
•

You must have prepared for data protection.
Preparing for data protection includes tasks such as installing SnapCenter, adding hosts, creating
storage system connections, and adding resources.

•

SVMs must be assigned to you for mirror or vault operations.
The SnapCenter administrator must have assigned the SVMs for both the source and destination
volumes to you if you are replicating Snapshot copies to a mirror or vault.

•

You must have manually added the resources that you want to protect.
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Steps

1. In the left navigation pane, click Settings.
2. In the Settings page, click Policies.
3. Click New.
4. In the Name page, enter the policy name and description.
5. In the Settings page, perform the following steps:
•

Specify the schedule type by selecting Hourly, Daily, Weekly, or Monthly.
Note: You can specify the schedule (start date, end date, and frequency) for the backup
operation while creating a resource group. This enables you to create resource groups that
share the same policy and backup frequency, but enables you to assign different backup
schedules to each policy.

•

In the Custom backup settings section, provide any specific backup settings that has to be
passed to the plug-in in key-value format. You can provide multiple key-values to be passed to
the plug-in.

6. In the Retention page, specify the retention settings for the backup type and the schedule type
selected in the Backup Type page:
If you want to...

Then...

Keep a certain number of
Snapshot copies

Select Total Snapshot copies to keep, and then specify the number of
Snapshot copies that you want to keep.
If the number of Snapshot copies exceeds the specified number, the
Snapshot copies are deleted with the oldest copies deleted first.
Important: You must set the retention count to 2 or higher if you plan
to enable SnapVault replication. If you set the retention count to 1, the
retention operation might fail because the first Snapshot copy is the
reference Snapshot copy for the SnapVault relationship until a newer
Snapshot copy is replicated to the target.
Note: The maximum retention value is 1018 for resources on ONTAP
9.4 or later, and 254 for resources on ONTAP 9.3 or earlier. Backups
will fail if retention is set to a value higher than what the underlying
ONTAP version supports.

Keep the Snapshot copies for
a certain number of days

Select Keep Snapshot copies for, and then specify the number of days
for which you want to keep the Snapshot copies before deleting them.

7. In the Replication page, specify the replication settings:
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For this field...

Do this...

Update SnapMirror
after creating a local
Snapshot copy

Select this field to create mirror copies of the backup sets on
another volume (SnapMirror replication).
If the protection relationship in ONTAP is of type Mirror and
Vault and if you select only this option, Snapshot copy created on
the primary will not be transferred to the destination, but will be
listed in the destination. If this Snapshot copy is selected from the
destination to perform a restore operation, then the following error
message is displayed: Secondary Location is not available for the
selected vaulted/mirrored backup.

Update SnapVault after
creating a local
Snapshot copy

Select this option to perform disk-to-disk backup replication
(SnapVault backups).

Secondary policy label

Select a Snapshot label.
Depending on the Snapshot label that you select, the ONTAP
software applies the secondary Snapshot copy retention policy that
determines how Snapshot copies are retained on the secondary
storage system.

Error retry count

Enter the maximum number of replication attempts that can be
allowed before the operation stops.

8. Review the summary and click Finish.
Related tasks

Backing up resource groups of custom plug-in resources on page 22
Related information

Installing and setting up SnapCenter

Backing up individual custom plug-in resources
If an individual custom plug-in resource is not part of any resource group, you can back up the
resource from the Resources page. You can back up the resource on demand, or, if the resource has a
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policy attached and a schedule configured, then backups occur automatically according to the
schedule.
Before you begin

•

You must have created a backup policy.

•

If you want to back up a resource that has a SnapMirror relationship with a secondary storage, the
role assigned to the storage user should include the “snapmirror all” privilege. However, if you
are using the “vsadmin” role, then the “snapmirror all” privilege is not required.

Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. Optional: In the Resources page, filter resources from the View drop-down list based on resource
type.
Click

, and then select the host name and the resource type to filter the resources. You can then

click

to close the filter pane.

3. Click the resource that you want to back up.
4. In the Resource page, if you want to use a custom name, select thes Use custom name format
for Snapshot copy check box , and then enter a custom name format for the Snapshot copy name.
Example

For example, customtext__policy_hostname or resource_hostname. By default, a
timestamp is appended to the Snapshot copy name
5. Optional: In the Application Settings page, do the following:
•

Click the Backups arrow to set additional backup options:
Enable consistency group backup, if needed, and perform the following tasks:
For this field...

Do this...

Afford time to wait for Consistency Group
Snapshot operation to complete

Select Urgent, Medium, or Relaxed to
specify the wait time for Snapshot copy
operation to complete. Urgent = 5 seconds,
Medium = 7 seconds, and Relaxed = 20
seconds.

Disable WAFL Sync

Select this to avoid forcing a WAFL
consistency point.
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•

Click the Scripts arrow to run pre and post commands for quiesce, Snapshot copy, and
unquiesce operations. You can also run pre commands before exiting the backup operation.
Prescripts and postscripts are run in the SnapCenter Server.

•

Click the Custom Configurations arrow, and then enter the custom value pairs required for
all jobs using this resource.

•

Click the Snapshot Copy Tool arrow to select the tool to create Snapshot copies:
If you want...

Then...

SnapCenter to take a storage level Snapshot
copy

Select SnapCenter without File System
Consistency.

SnapCenter to use the plug-in for Windows
to put the file system into a consistent state
and then take a Snapshot copy

Select SnapCenter with File System
Consistency.

To enter the command to create a Snapshot
copy

Select Other, and then enter the command
to create a Snapshot copy.

6. In the Policies page, perform the following steps:
a. Select one or more policies from the drop-down list.
Note: You can also create a policy by clicking

.

In the Configure schedules for selected policies section, the selected policies are listed.
b. Click
in the Configure Schedules column for the policy for which you want to
configure a schedule.
c. In the Add schedules for policy policy_name dialog box, configure the schedule, and then
click OK.
Where, policy_name is the name of the policy that you have selected.
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The configured schedules are listed in the Applied Schedules column.
7. In the Notification page, from the Email preference drop-down list, select the scenarios in which
you want to send the emails.
You must also specify the sender and receiver email addresses, and the subject of the email.
SMTP must also be configured in Settings > Global Settings.
8. Review the summary, and then click Finish.
The resources topology page is displayed.
9. Click Back up Now.
10. In the Backup page, perform the following steps:
a. If you have applied multiple policies to the resource, from the Policy drop-down list, select
the policy that you want to use for backup.
b. Click Backup.
11. Monitor the operation progress by clicking Monitor > Jobs.

Creating resource groups and attaching policies
A resource group is the container to which you must add resources that you want to back up and
protect. A resource group enables you to back up all the data that is associated with a given
application simultaneously. A resource group is required for any data protection job. You must also
attach one or more policies to the resource group to define the type of data protection job that you
want to perform.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, click New Resource Group.
3. In the Name page, perform the following actions:
For this field...

Do this...

Name

Enter a name for the resource group.

Tags

Enter one or more labels that will help you
later search for the resource group.
For example, if you add HR as a tag to
multiple resource groups, you can later find
all resource groups associated with the HR
tag.

Use custom name format for Snapshot copy

Select this check box, and enter a custom
name format that you want to use for the
Snapshot copy name.
For example, customtext_resource
group_policy_hostname or resource
group_hostname. By default, a timestamp is
appended to the Snapshot copy name.

4. Optional: In the Resources page, select a host name from the Host drop-down list and resource
type from the Resource Type drop-down list.
This helps to filter information on the screen.
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5. Select the resources from the Available Resources section, and then click the right arrow to move
them to the Selected Resources section.
6. Optional: In the Application Settings page, do the following:
•

Click the Backups arrow to set additional backup options:
Enable consistency group backup and perform the following tasks:
For this field...

Do this...

Afford time to wait for Consistency Group
Snapshot operation to complete

Select Urgent, Medium, or Relaxed to
specify the wait time for Snapshot copy
operation to complete. Urgent = 5 seconds,
Medium = 7 seconds, and Relaxed = 20
seconds.

Disable WAFL Sync

Select this to avoid forcing a WAFL
consistency point.

•

Click the Scripts arrow and enter the pre and post commands for quiesce, Snapshot copy, and
unquiesce operations. You can also enter the pre commands to be executed before exiting in
the event of a failure.

•

Click the Custom Configurations arrow and enter the custom key-value pairs required for all
data protection operations using this resource.

•

Click the Snapshot Copy Tool arrow to select the tool to create Snapshot copies:
If you want...

Then...

SnapCenter to use the plug-in for Windows
and put the file system into a consistent state
before creating a Snapshot copy. For Linux
resources, this option is not applicable.

Select SnapCenter with File System
Consistency.
This option is not applicable for SnapCenter
Plug-in for SAP HANA Database.
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If you want...

Then...

SnapCenter to create a storage level
Snapshot copy

Select SnapCenter without File System
Consistency.

To enter the command to be executed on the
host to create Snapshot copies.

Select Other, and then enter the command
to be executed on the host to create a
Snapshot copy.

7. In the Policies page, perform the following steps:
a. Select one or more policies from the drop-down list.
Note: You can also create a policy by clicking

.

The policies are listed in the Configure schedules for selected policies section.
b. In the Configure Schedules column, click

for the policy you want to configure.

c. In the Add schedules for policy policy_name dialog box, configure the schedule, and then
click OK.
Where, policy_name is the name of the policy that you have selected.
The configured schedules are listed in the Applied Schedules column.
8. In the Notification page, from the Email preference drop-down list, select the scenarios in which
you want to send the emails.
You must also specify the sender and receiver email addresses, and the subject of the email. The
SMTP server must be configured in Settings > Global Settings.
9. Review the summary and click Finish.
Related tasks

Backing up resource groups of custom plug-in resources on page 22

Backing up resource groups of custom plug-in resources
A resource group is a collection of resources on a host or cluster. A backup operation on the resource
group is performed on all resources defined in the resource group. You can back up a resource group
on demand from the Resources page. If a resource group has a policy attached and a schedule
configured, then backups occur automatically according to the schedule.
Before you begin

•

You must have created a resource group with a policy attached.

•

If you want to back up a resource that has a SnapMirror relationship to secondary storage, the role
assigned to the storage user should include the “snapmirror all” privilege. However, if you are
using the “vsadmin” role, then the “snapmirror all” privilege is not required.

About this task

Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
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2. In the Resources page, select Resource Group from the View list.
You can search the resource group either by entering the resource group name in the search box
or by clicking

and selecting the tag. You can then click

to close the filter pane.

3. In the Resource Groups page, select the resource group that you want to back up, and then click
Back up Now.
4. In the Backup page, perform the following steps:
a. If you have associated multiple policies with the resource group, from the Policy drop-down
list, select the policy that you want to use for backup.
b. Click Backup.
5. Monitor the operation progress by clicking Monitor > Jobs.
Related tasks

Creating policies for custom plug-in resources on page 15
Creating resource groups and attaching policies on page 20
Monitoring backup operations on page 23
Viewing custom plug-in resource related backups and clones in the Topology page on page 25

Monitoring backup operations
You can monitor the progress of different backup operations by using the SnapCenter Jobs page. You
might want to check the progress to determine when it is complete or if there is an issue.
About this task

The following icons appear on the Jobs page and indicate the state of the operation:
•

In progress

•

Completed successfully

•

Failed

•

Completed with warnings or could not start due to warnings

•

Queued

•

Canceled

Steps

1. In the left navigation pane, click Monitor.
2. In the Monitor page, click Jobs.
3. Optional: In the Jobs page, perform the following steps:
a. Click

to filter the list so that only backup operations are listed.

b. Specify the start and end dates.
c. From the Type drop-down list, select Backup.
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d. From the Status drop-down, select the backup status.
e. Click Apply to view the operations completed successfully.
4. Select a backup job, and then click Details to view the job details.
Note: Though the backup job status displays
, when you click on job details you might see
that some of the child tasks of the backup operation are still in progress.

5. Optional: In the Job Details page, click View logs.
The View logs button displays the detailed logs for the selected operation.
Related tasks

Backing up resource groups of custom plug-in resources on page 22

Monitoring operations in the Activity pane
The Activity pane displays the five most recent operations performed. The Activity pane also
displays when the operation was initiated and the status of the operation.
About this task

The Activity pane displays information regarding backup, restore, clone, and scheduled backup
operations.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. Click

on the Activity pane to view the five most recent operations.

When you click one of the operations, the operation details are listed in the Job Details page.

Canceling the backup operations
You can cancel backup operations that are queued.
Before you begin

•

You must be logged in as the SnapCenter Admin or job owner to cancel operations.

About this task

•

You can cancel a backup operation from either the Monitor page or the Activity pane.

•

You can use the SnapCenter GUI, PowerShell cmdlets, or CLI commands to cancel the backup
operations.

•

The Cancel Job button is disabled for operations that cannot be canceled.

•

If you selected All members of this role can see and operate on other members objects in
Users\Groups page while creating a role, you can cancel the queued backup operations of other
members while using that role.

Step

1. Perform one of the following actions:
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From the…
Monitor page

Action
a. In the left navigation pane, click Monitor
> Jobs.
b. Select the operation, and click Cancel
Job.

Activity pane

a. After initiating the backup operation, click
on the Activity pane to view the five
most recent operations.
b. Select the operation.
c. In the Job Details page, click Cancel Job.

Result

The operation is canceled, and the resource is reverted to the previous state.
Related information

SnapCenter Software 4.2 Windows Cmdlet Reference Guide

Viewing custom plug-in resource related backups and
clones in the Topology page
When you are preparing to back up or clone a resource, you might find it helpful to view a graphical
representation of all backups and clones on the primary and secondary storage. In the Topology page,
you can see all of the backups and clones that are available for the selected resource or resource
group. You can view the details of those backups and clones, and then select them to perform data
protection operations.
About this task

You can review the following icons in the Manage Copies view to determine whether the backups
and clones are available on the primary or secondary storage (Mirror copies or Vault copies).

•

•

displays the number of backups and clones that are available on the primary storage.

displays the number of backups and clones that are mirrored on the secondary storage
using SnapMirror technology.
Note: Clones of a backup of a version-flexible mirror on a mirror-vault type volume are

displayed in the topology view but the mirror backup count in the topology view does not
include the version-flexible backup.

•

displays the number of backups and clones that are replicated on the secondary storage
using SnapVault technology.
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Note: The number of backups displayed includes the backups deleted from the secondary
storage. For example, if you have created 6 backups using a policy to retain only 4 backups, the
number of backups displayed are 6.
Note: Clones of a backup of a version-flexible mirror on a mirror-vault type volume are displayed

in the topology view but the mirror backup count in the topology view does not include the
version-flexible backup.
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, either select the resource or resource group from the View drop-down list.
3. Select the resource either from the resource details view or from the resource group details view.
If the resource is protected, the topology page of the selected resource is displayed.
4. Review the Summary card to see a summary of the number of backups and clones available on
the primary and secondary storage.
The Summary Card section displays the total number of backups and clones.
Clicking the refresh button starts a query of the storage to display an accurate count.
5. In the Manage Copies view, click Backups or Clones from the primary or secondary storage to
see details of a backup or clone.
The details of the backups and clones are displayed in a table format.
6. Select the backup from the table, and then click the data protection icons to perform restore,
clone, rename, and delete operations.
Note: You cannot rename or delete backups that are on the secondary storage system.

You cannot rename the backups that are on the primary storage system.

7. If you want to delete a clone, then select the clone from the table and click
Related tasks

Backing up resource groups of custom plug-in resources on page 22

to delete the clone.
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Restoring custom plug-in resources
The restore and recovery workflow includes planning, performing the restore operations, and
monitoring the operations.
About this task

The following workflow shows the sequence in which you must perform the restore operation:

You can also use PowerShell cmdlets manually or in scripts to perform backup, restore, and clone
operations. The SnapCenter cmdlet help and the cmdlet reference information contain detailed
information about PowerShell cmdlets.
Related references

Data protection workflow for SnapCenter Custom Plug-ins resources on page 7
Related information

SnapCenter Software 4.2 Windows Cmdlet Reference Guide

Restoring a resource backup
You can use SnapCenter to restore resources. The capabilities of the restore operations depends upon
the plug-in that you use.
Before you begin

•

You must have backed up the resource or resource groups.

•

The SnapCenter administrator must have assigned you the storage virtual machines (SVMs) for
both the source volumes and destination volumes if you are replicating Snapshot copies to a
mirror or vault.

•

You must have cancelled any backup operation that is currently in progress for the resource or
resource group you want to restore.

About this task

The default restore operation only restores storage objects. Restore operations at the application level
can only be performed if the custom plug-in provides that capability.
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Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, filter resources from the View drop-down list based on resource type.
The resources are displayed along with information such as type, host or cluster name, associated
resource groups and policies, and status.
Note: Although a backup might be for a resource group, when you restore, you must select the
individual resources you want to restore.

If the resource is not protected, Not protected is displayed in the Overall Status column.
The status Not protected in the Overall Status column can mean either that the resource is not
protected, or that the resource was backed up by a different user.
3. Select the resource or select a resource group and then select a resource in that group.
The resource topology page is displayed.
4. From the Manage Copies view, select Backups either from the primary or secondary (mirrored
or vaulted) storage systems.
5. In the Primary backup(s) table, select the backup that you want to restore from, and then click
.

6. In the Restore Scope page, select either Complete Resource or File Level.
a. If you selected Complete Resource, the resource backup is restored.
If the resource contains volumes or qtrees as Storage Footprint, then newer Snapshot copies
on such volumes or qtrees are deleted and cannot be recovered. Also, if any other resource is
hosted on same volumes or qtrees, then that resource is also deleted.
b. If you selected File Level, then you can either select All, or select volumes or qtrees, and then
enter the path related to the volumes or qtrees that are selected separated by commas.
•

You can select multiple volumes and qtrees.

•

If resource type is LUN, entire LUN is restored. You can select multiple LUNs.
Note: If you select All, all the files on the volumes, qtrees, or LUNs are restored.

7. In the Recovery Type page, perform the following steps: select option to apply logs. Make sure
your plugin supports All logs and Logs until restore type before selecting it.
If you want to...

Do this...

Restore all logs

Select All logs.
Ensure that the plug-in supports All logs.
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If you want to...

Do this...

Restore all logs till the specified time

Select Logs until.
Ensure that the plug-in supports Logs until.

Restore the resource backup

Select None.

8. Optional: In the Pre ops page, enter pre restore and unmount commands to run before performing
a restore job.
9. Optional: In the Post ops page, enter mount and post restore commands to run after performing a
restore job.
10. In the Notification page, from the Email preference drop-down list, select the scenarios in which
you want to send the emails.
You must also specify the sender and receiver email addresses, and the subject of the email.
SMTP must also be configured in the Settings > Global Settings page.
11. Review the summary, and then click Finish.
12. Monitor the operation progress by clicking Monitor > Jobs.

Monitoring restore operations
You can monitor the progress of different SnapCenter restore operations by using the Jobs page. You
might want to check the progress of an operation to determine when it is complete or if there is an
issue.
About this task

Post-restore states describe the conditions of the resource after a restore operation and any further
restore actions that you can take.
The following icons appear on the Jobs page, and indicate the state of the operation:
•

In progress

•

Completed successfully

•

Failed

•

Completed with warnings or could not start due to warnings

•

Queued

•

Canceled

Steps

1. In the left navigation pane, click Monitor.
2. In the Monitor page, click Jobs.
3. Optional: In the Jobs page, perform the following steps:
a. Click

to filter the list so that only restore operations are listed.

b. Optional: Specify the start and end dates.
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c. From the Type drop-down list, select Restore.
d. From the Status drop-down list, select the restore status.
e. Click Apply to view the operations that are completed successfully.
4. Select the restore job, and then click Details to view the job details.
5. Optional: In the Job Details page, click View logs.
The View logs button displays the detailed logs for the selected operation.

Canceling restore operations
You can cancel restore jobs that are queued.
Before you begin

•

You must be logged in as the SnapCenter Admin or job owner to cancel restore operations.

About this task

•

You can cancel a restore operation from either the Monitor page or the Activity pane.

•

You cannot cancel a running restore operation.

•

You can use the SnapCenter GUI, PowerShell cmdlets, or CLI commands to cancel the restore
operations.

•

The Cancel Job button is disabled for restore operations that cannot be canceled.

•

If you selected All members of this role can see and operate on other members objects in
Users\Groups page while creating a role, you can cancel the queued backup operations of other
members while using that role.

Step

1. Perform one of the following actions:
From the…
Monitor page

Action
a. In the left navigation pane, click Monitor
> Jobs.
b. Select the job and click Cancel Job.

Activity pane

a. After initiating the restore operation, click
on the Activity pane to view the five
most recent operations.
b. Select the operation.
c. In the Job Details page, click Cancel Job.

Related information

SnapCenter Software 4.2 Windows Cmdlet Reference Guide
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Cloning custom plug-in resource backups
The clone workflow includes performing the clone operation and monitoring the operation.
About this task

You might clone resource backups for the following reasons:
•

To test functionality that has to be implemented using the current resource structure and content
during application development cycles

•

For data extraction and manipulation tools when populating data warehouses

•

To recover data that was mistakenly deleted or changed

The following workflow shows the sequence in which you must perform the clone operation:

You can also use PowerShell cmdlets manually or in scripts to perform backup, restore, and clone
operations. For detailed information about PowerShell cmdlets, use the SnapCenter cmdlet help or
see the cmdlet reference information.
Related references

Data protection workflow for SnapCenter Custom Plug-ins resources on page 7
Related information

SnapCenter Software 4.2 Windows Cmdlet Reference Guide

Cloning from a backup
You can use SnapCenter to clone a backup. You can clone from primary or secondary backup. The
capabilities of the clone operations depends upon the plug-in that you use.
Before you begin

•

You must have backed up the resources or resource group.

•

The default clone operation only clones storage objects. Clone operations at the application level
can only be performed if the custom plug-in provides that capability.
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Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, filter resources from the View drop-down list based on resource type.
The resources are displayed along with information such as type, host or cluster name, associated
resource groups and policies, and status.
3. Select the resource or resource group.
You must select a resource if you select a resource group.
The resource or resource group topology page is displayed.
4. From the Manage Copies view, select Backups either from the primary or secondary (mirrored
or vaulted) storage systems.
5. Select the data backup from the table, and then click

.

6. In the Locations page, perform the following:
For this field...

Do this...

Clone server

By default, the source host is populated.
If you want to specify a different host, select the host on which the
clone should be mounted and the plug-in is installed.

Clone suffix

This is mandatory when the clone destination is the same as the
source. Enter a suffix that will be appended to the newly cloned
resource name. The suffix ensures that the cloned resource is unique
on the host.
For example, rs1_clone. If you are cloning to the same host as the
original resource, you must provide a suffix to differentiate the
cloned resource from the original resource; otherwise, the operation
fails.

If the resource selected is a LUN and if you are cloning from a secondary backup, then the
destination volumes are listed. Single source can have multiple destination volumes.
7. In the Settings page, perform the following:
For this field...

Do this...

Initiator name

Enter the host initiator name, which is either a IQDN or WWPN.

Igroup protocol

Select Igroup protocol.

Note: Settings page is displayed only if the storage type is LUN.

8. Optional: In the Scripts page, enter the commands for pre clone or post clone that should be run
before or after the clone operation, respectively. Enter the mount command to mount a file system
to a host.
For example:
Pre clone command: delete existing databases with the same name
Post clone command: verify a database or start a database.
Mount command for a volume or qtree on a Linux machine: mount<VSERVER_NAME>:
%<VOLUME_NAME_Clone /mnt>
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9. In the Notification page, from the Email preference drop-down list, select the scenarios in which
you want to send the emails.
You must also specify the sender and receiver email addresses, and the subject of the email.
10. Review the summary and click Finish.
11. Monitor the operation progress by clicking Monitor > Jobs.
Related information

NetApp Knowledgebase Answer 1087842: Database credential does not propagate to the cloned
resource

Monitoring clone operations from the Jobs page
You can monitor the progress of SnapCenter clone operations by using the Jobs page. You might
want to check the progress of an operation to determine when it is complete or if there is an issue.
About this task

The following icons appear on the Jobs page, and indicate the state of the operation:
•

In progress

•

Completed successfully

•

Failed

•

Completed with warnings or could not start due to warnings

•

Queued

Steps

1. In the left navigation pane, click Monitor.
2. In the Monitor page, click Jobs.
3. Optional: In the Jobs page, perform the following steps:
a. Click

to filter the list so that only clone operations are listed.

b. Specify the start and end dates.
c. From the Type drop-down list, select Clone.
d. From the Status drop-down list, select the clone status.
e. Click

to view the operations that are completed successfully.

4. Select the clone job, and then click Details to view the job details.
5. Optional: In the Job Details page, click View logs.
The View logs button displays the detailed logs for the selected operation.
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Canceling clone operations
You can cancel clone operations that are queued.
Before you begin

•

You must be logged in as the SnapCenter Admin or job owner to cancel operations.

About this task

•

You can cancel a clone operation from either the Monitor page or the Activity pane.

•

You cannot cancel a running clone operation.

•

You can use the SnapCenter GUI, PowerShell cmdlets, or CLI commands to cancel the clone
operations.

•

If you selected All members of this role can see and operate on other members objects in
Users\Groups page while creating a role, you can cancel the queued backup operations of other
members while using that role.

Step

1. Perform one of the following actions:
From the…
Monitor page

Action
a. In the left navigation pane, click Monitor
> Jobs.
b. Select the operation, and click Cancel
Job.

Activity pane

a. After initiating the clone operation, click
on the Activity pane to view the five
most recent operations.
b. Select the operation.
c. In the Job Details page, click Cancel Job.

Related information

SnapCenter Software 4.2 Windows Cmdlet Reference Guide

Splitting a clone
You can use SnapCenter to split a cloned resource from the parent resource. The clone that is split
becomes independent of the parent resource.
About this task

•

You cannot perform the clone split operation on an intermediate clone.
For example, after you create clone1 from a database backup, you can create a backup of clone1,
and then clone this backup (clone2). After you create clone2, clone1 is an intermediate clone, and
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you cannot perform the clone split operation on clone1. However, you can perform the clone split
operation on clone2.
After splitting clone2, you can perform the clone split operation on clone1 because clone1 is no
longer the intermediate clone.
•

When you split a clone, the backup copies and clone jobs of the clone are deleted.

•

For information about clone split operation limitations, see the Logical Storage Management
Guide.

ONTAP 9 Logical Storage Management Guide
Steps

1. In the left navigation pane, click Resources, and then select the appropriate plug-in from the list.
2. In the Resources page, select the appropriate option from the View list:
Option

Description

For database applications

Select Database from the View list.

For file systems

Select Path from the View list.

3. Select the cloned resource (for example, the database or LUN), and then click

.

4. Review the estimated size of the clone that is to be split and the required space available on the
aggregate, and then click Start.
5. Monitor the operation progress by clicking Monitor > Jobs.
After you finish

If you want a longer poll time or shorter poll time to check whether the clone is split or not, you can
change the value of CloneSplitStatusCheckPollTime parameter in
SMCoreServiceHost.exe.config file to set the time interval for SMCore to poll for the status of
the clone split operation. The value is in milliseconds and the default value is 5 minutes.
For example:
<add key="CloneSplitStatusCheckPollTime" value="300000" />
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Backing up, restoring, and cloning using
PowerShell cmdlets
With SnapCenter Custom Plug-ins, you can use PowerShell cmdlets for scripting of backup, restore,
and clone operations.
The following are common tasks you might perform using PowerShell cmdlets:
•

Preparing the PowerShell environment

•

Creating a storage system connection and a credential

•

Backing up resources

•

Restoring backups

•

Cloning backups

The information regarding the parameters that can be used with the cmdlet and their descriptions can
be obtained by runningGet-Help command_name. Alternatively, you can also refer to the Cmdlet
Reference Guide.
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Related information

SnapCenter Software 4.2 Windows Cmdlet Reference Guide

Creating a storage system connection and a credential
using PowerShell cmdlets
You must create a storage virtual machine (SVM) connection and a credential before using
PowerShell cmdlets to perform data protection operations.
Before you begin

•

You should have prepared the PowerShell environment to execute the PowerShell cmdlets.

•

You should have the required permissions in the Infrastructure Admin role to create storage
connections.

•

You should ensure that the plug-in installations are not in progress.
Host plug-in installations must not be in progress while adding a storage system connection
because the host cache might not be updated and databases status might be displayed in the
SnapCenter GUI as “Not available for backup” or “Not on NetApp storage”.

•

Storage system names should be unique.
SnapCenter does not support multiple storage systems with the same name on different clusters.
Each storage system that is supported by SnapCenter should have a unique name and a unique
data LIF IP address.

About this task

The information regarding the parameters that can be used with the cmdlet and their descriptions can
be obtained by runningGet-Help command_name. Alternatively, you can also refer to the Cmdlet
Reference Guide.
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Steps

1. Initiate a PowerShell connection session by using the Open-SmConnection cmdlet.
Example

This example opens a PowerShell session:
PS C:\> Open-SmStorageConnection

2. Create a new connection to the storage system by using the Add-SmStorageConnection
cmdlet.
Example

This example creates a new storage system connection:
PS C:\> Add-SmStorageConnection -Storage test_vs1 -Protocol Https
-Timeout 60

3. Create a new credential by using the Add-SmCredential cmdlet.
Example

This example creates a new credential named FinanceAdmin with Windows credentials:
PS C:> Add-SmCredential -Name FinanceAdmin -AuthMode Windows
-Credential sddev\administrator

Backing up resources using PowerShell cmdlets
Backing up a resource includes establishing a connection with the SnapCenter Server, adding
resources, adding a policy, creating a backup resource group, and backing up.
Before you begin

•

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.

•

You must have added the storage system connection and created a credential.

About this task

The information regarding the parameters that can be used with the cmdlet and their descriptions can
be obtained by runningGet-Help command_name. Alternatively, you can also refer to the Cmdlet
Reference Guide.

SnapCenter Software 4.2 Windows Cmdlet Reference Guide
Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the OpenSmConnection cmdlet.
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Example
Open-smconnection

-SMSbaseurl

https:\\snapctr.demo.netapp.com:8146\

The username and password prompt is displayed.
2. Add resources by using the Add-SmResources cmdlet.
Example

This example adds resources:
Add-SmResource -HostName '10.232.206.248' -PluginCode 'DB2' ResourceName NONREC1 -ResourceType Database -StorageFootPrint ( @
{"VolumeName"="DB2_NONREC1DB";"LunName"="DB2_NONREC1DB";"Vserver"="vse
rver_scauto_secondary"}) -Instance db2inst1

3. Create a backup policy by using the Add-SmPolicy cmdlet.
Example

This example creates a new backup policy:
Add-SMPolicy -PolicyName 'db2VolumePolicy' -PolicyType 'Backup' PluginPolicyType DB2 -description 'VolumePolicy'

4. Add a new resource group to SnapCenter by using the Add-SmResourceGroup cmdlet.
Example

This example creates a new resource group with the specified policy and resources:
Add-SmResourceGroup -ResourceGroupName
'Verify_ManualBackup_DatabaseLevel_MultipleVolume_unix' -Resources @(@
{"Host"="10.232.206.248";"Uid"="db2inst2\NONREC"},@{"Host"="10.232.206
.248";"Uid"="db2inst1\NONREC"}) -Policies db2ManualPolicy

5. Initiate a new Snapshot copy job by using the New-SmBackup cmdlet.
Example
New-SMBackup -DatasetName
Verify_ManualBackup_DatabaseLevel_MultipleVolume_unix -Policy
db2ManualPolicy

6. View the status of the backup job by using the Get-SmBackupReport cmdlet.
Example

This example displays a job summary report of all jobs that were run on the specified date:
PS C:\> Get-SmBackupReport -JobId 351
Output:
BackedUpObjects
: {DB1}
FailedObjects
: {}
IsScheduled
: False
HasMetadata
: False
SmBackupId
: 269
SmJobId
: 2361
StartDateTime
: 10/4/2016 11:20:45 PM
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EndDateTime
: 10/4/2016 11:21:32 PM
Duration
: 00:00:46.2536470
CreatedDateTime
: 10/4/2016 11:21:09 PM
Status
: Completed
ProtectionGroupName
: Verify_ASUP_Message_windows
SmProtectionGroupId
: 211
PolicyName
: test2
SmPolicyId
: 20
BackupName
:
Verify_ASUP_Message_windows_scc54_10-04-2016_23.20.46.2758
VerificationStatus
: NotVerified
VerificationStatuses
:
SmJobError
:
BackupType
: SCC_BACKUP
CatalogingStatus
: NotApplicable
CatalogingStatuses
:
ReportDataCreatedDateTime :

Restoring resources using PowerShell cmdlets
Restoring a resource backup includes initiating a connection session with the SnapCenter Server,
listing the backups and retrieving backup information, and restoring a backup.
Before you begin

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.
About this task

The information regarding the parameters that can be used with the cmdlet and their descriptions can
be obtained by runningGet-Help command_name. Alternatively, you can also refer to the Cmdlet
Reference Guide.
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Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the OpenSmConnection cmdlet.
Example
Open-smconnection

-SMSbaseurl

https:\\snapctr.demo.netapp.com:8146/

2. Retrieve the information about the one or more backups that you want to restore by using the
Get-SmBackup and Get-SmBackupReport cmdlets.
Example

This example displays information about all available backups:
C:\PS>PS C:\> Get-SmBackup
BackupId
BackupTime
----------------1

BackupName
BackupType
------------------Payroll Dataset_vise-f6_08... 8/4/2015

40 | Data Protection Guide for Custom Plug-ins

11:02:32 AM
2
11:23:17 AM

Full Backup
Payroll Dataset_vise-f6_08... 8/4/2015

Example

This example displays detailed information about the backup from January 29th 2015 to February
3rd, 2015:
PS C:\> Get-SmBackupReport -FromDateTime "1/29/2015" -ToDateTime
"2/3/2015"
SmBackupId
: 113
SmJobId
: 2032
StartDateTime
: 2/2/2015 6:57:03 AM
EndDateTime
: 2/2/2015 6:57:11 AM
Duration
: 00:00:07.3060000
CreatedDateTime
: 2/2/2015 6:57:23 AM
Status
: Completed
ProtectionGroupName : Clone
SmProtectionGroupId : 34
PolicyName
: Vault
SmPolicyId
: 18
BackupName
: Clone_SCSPR0019366001_02-02-2015_06.57.08
VerificationStatus
: NotVerified
SmBackupId
SmJobId
StartDateTime
EndDateTime
Duration
CreatedDateTime
Status
ProtectionGroupName
SmProtectionGroupId
PolicyName
SmPolicyId
BackupName
VerificationStatus

:
:
:
:
:
:
:
:
:
:
:
:
:

114
2183
2/2/2015 1:02:41 PM
2/2/2015 1:02:38 PM
-00:00:03.2300000
2/2/2015 1:02:53 PM
Completed
Clone
34
Vault
18
Clone_SCSPR0019366001_02-02-2015_13.02.45
NotVerified

3. Restore data from the backup by using the Restore-SmBackup cmdlet.
Example
Restore-SmBackup -PluginCode 'DummyPlugin' -AppObjectId
'scc54.sccore.test.com\DummyPlugin\NTP\DB1' -BackupId 269 -Confirm:
$false
output:
Name
: Restore 'scc54.sccore.test.com\DummyPlugin\NTP
\DB1'
Id
: 2368
StartTime
: 10/4/2016 11:22:02 PM
EndTime
:
IsCancellable
: False
IsRestartable
: False
IsCompleted
: False
IsVisible
: True
IsScheduled
: False
PercentageCompleted : 0
Description
:
Status
: Queued
Owner
:
Error
:
Priority
: None
Tasks
: {}
ParentJobID
: 0
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EventId
JobTypeId
ApisJobKey
ObjectId
PluginCode
PluginName

: 0
:
:
: 0
: NONE
:

Cloning backups using PowerShell cmdlets
The clone workflow includes planning, performing the clone operation, and monitoring the
operation.
Before you begin

You must have prepared the PowerShell environment to execute the PowerShell cmdlets.
About this task

For information about PowerShell cmdlets, use the SnapCenter cmdlet help or see the cmdlet
reference information.

SnapCenter Software 4.2 Windows Cmdlet Reference Guide
Steps

1. Initiate a connection session with the SnapCenter Server for a specified user by using the OpenSmConnection cmdlet.
Example
Open-SmConnection

-SMSbaseurl

https:\\snapctr.demo.netapp.com:8146/

2. List the backups that can be cloned using the Get-SmBackup or Get-SmResourceGroup
cmdlet.
Example

This example displays information about all available backups:
C:\PS>PS C:\> Get-SmBackup
BackupId
BackupTime
----------------1
11:02:32 AM
2
11:23:17 AM

BackupName
BackupType
------------------Payroll Dataset_vise-f6_08... 8/4/2015
Full Backup
Payroll Dataset_vise-f6_08... 8/4/2015

Example

This example displays information about a specified resource group:
PS C:\> Get-SmResourceGroup
Description
CreationTime
ModificationTime

:
: 10/10/2016 4:45:53 PM
: 10/10/2016 4:45:53 PM
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EnableEmail
EmailSMTPServer
EmailFrom
EmailTo
EmailSubject
EnableSysLog
ProtectionGroupType
EnableAsupOnFailure
Policies
HostResourceMaping
Configuration
LastBackupStatus
VerificationServer
EmailBody
EmailNotificationPreference
VerificationServerInfo
SchedulerSQLInstance
CustomText
CustomSnapshotFormat
SearchResources
ByPassCredential
IsCustomSnapshot
MaintenanceStatus
PluginProtectionGroupTypes
Tag
IsInternal
EnableEmailAttachment
VerificationSettings
Name
Type
Id
Host
UserName
Passphrase
Deleted
Auth
IsClone
CloneLevel
Hosts
StorageName
ResourceGroupNames
PolicyNames

:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:

Description
CreationTime
ModificationTime
EnableEmail
EmailSMTPServer
EmailFrom
EmailTo
EmailSubject
EnableSysLog
ProtectionGroupType
EnableAsupOnFailure
Policies
HostResourceMaping
Configuration
LastBackupStatus
VerificationServer
EmailBody
EmailNotificationPreference
VerificationServerInfo
SchedulerSQLInstance
CustomText
CustomSnapshotFormat
SearchResources
ByPassRunAs
IsCustomSnapshot
MaintenanceStatus
PluginProtectionGroupTypes
Tag

:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:

False

False
Backup
False
{}
{}
SMCoreContracts.SmCloneConfiguration
Completed
Never

False
False
Production
{SMSQL}
False
False
{}
NFS_DB
Group
2

False
SMCoreContracts.SmAuth
False
0

10/10/2016 4:51:36 PM
10/10/2016 5:27:57 PM
False

False
Backup
False
{}
{}
SMCoreContracts.SmCloneConfiguration
Failed
Never

False
False
Production
{SMSQL}
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IsInternal
EnableEmailAttachment
VerificationSettings
Name
Type
Id
Host
UserName
Passphrase
Deleted
Auth
IsClone
CloneLevel
Hosts
StorageName
ResourceGroupNames
PolicyNames

:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:

False
False
{}
Test
Group
3

False
SMCoreContracts.SmAuth
False
0

3. Initiate a clone operation from a clone resource group or an existing backup using the NewSmClone cmdlet.
Example

This example creates a clone from a specified backup with all logs:
New-SmClone -BackupName
Verify_delete_clone_on_qtree_windows_scc54_10-04-2016_19.05.48.0886 Resources @{"Host"="scc54.sccore.test.com";"Uid"="QTREE1"} CloneToInstance scc54.sccore.test.com -Suffix '_QtreeCloneWin9' AutoAssignMountPoint -AppPluginCode 'DummyPlugin' -initiatorname 'iqn.
199105.com.microsoft:scc54.sccore.test.com' -igroupprotocol 'mixed'

4. View the status of the clone job by using the Get-SmCloneReport cmdlet.
Example

This example displays a clone report for the specified job ID:
PS C:\> Get-SmCloneReport -JobId 186
SmCloneId
SmJobId
StartDateTime
EndDateTime
Duration
Status
ProtectionGroupName
SmProtectionGroupId
PolicyName
SmPolicyId
BackupPolicyName
SmBackupPolicyId
CloneHostName
CloneHostId
CloneName
SourceResources
ClonedResources
Sally_DRAPER}
SmJobError

:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:
:

1
186
8/3/2015 2:43:02 PM
8/3/2015 2:44:08 PM
00:01:06.6760000
Completed
Draper
4
OnDemand_Clone
4
OnDemand_Full_Log
1
SCSPR0054212005.mycompany.com
4
Draper__clone__08-03-2015_14.43.53
{Don, Betty, Bobby, Sally}
{Don_DRAPER, Betty_DRAPER, Bobby_DRAPER,
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Troubleshooting data protection operations
If you encounter unexpected behavior while performing data protection operations, you can use the
log files to identify the cause and resolve the problem.
You can download the log files from the SnapCenter user interface by clicking Monitor > Logs >
Download.

Custom plug-in installation fails
Description
If the Java Runtime Environment (JRE) 1.7 is installed on a host with German operating system and
if this host is added to the SnapCenter Server, the custom plug-in installation fails.
Error message
Internal Server Error.

Corrective action
Upgrade the JRE version to 1.8.

Backup operation fails if Snapshot copies on the secondary
storage reaches maximum limit
Description
When the number of Snapshot copies on the secondary storage (mirror-vault) reaches the maximum
limit, the activity to register backup and apply retention in the backup operation fails.
Error message
This Snapshot copy is currently used as a reference Snapshot copy by one or
more SnapMirror relationships. Deleting the Snapshot copy can cause future
SnapMirror operations to fail.

Corrective action
You should configure SnapMirror retention policy for the secondary storage to avoid reaching the
maximum limit of Snapshot copies on the secondary storage.

Clone split estimation fails when the aggregate does not
have space
Description
If the aggregate has no space, clone split estimation fails.
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Corrective action
Increase the space on the aggregate.

Clone split start operation fails
Description
The clone split start operation fails when one of the following conditions are met:
•

The volume or aggregate is offline.

•

A clone split operation, backup operation, or restore operation is in progress on the clone
resource.

•

A clone split operation is in progress on an intermediate clone.

Corrective action
•

If the volume or aggregate is offline, check the status of the volume or aggregate on the storage
system and bring it back online.

•

If a clone split operation, backup operation, or restore operation is in progress on the clone
resource, restart the clone split operation after the clone split operation, backup operation, or
restore operation is complete.

•

If a clone split operation is in progress on an intermediate clone, split the child clones, and then
restart the clone split start operation on this clone.

Clone split operation stops responding
Description
The clone split operation stops responding if the SMCore service restarts.
Corrective action
Use the Stop-SmJob cmdlet to stop the clone split operation, and then perform the clone split
operation again.

Databases on which the clone split operation was performed
are listed as clones
Description
During the clone split operation, if the SMCore service restarts, the status of the operation will not be
sent to the server. Therefore, the databases on which the clone split operation was performed are
listed as clones in the Resources page.
Corrective action
Run the split clone cmdlet again to clean the clone metadata in SnapCenter repository.
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Restore operation times out
Description
During a restore operation that accesses VMs, the vCenter Server timed out while waiting for a
response from the SnapCenter server.
This error can occur when VMotion or the actual restore operation exceeds the timeout set for
responses from the SnapCenter server.
Error message
The operation has timed out

Corrective action
You can increase the SnapCenter server timeout value by including the following REST API in the
appsetting section of the SMCoreServiceHost.exe.Config file located under SmCore in the
SnapCenter Server:
<add key="RESTTimeout" value="timeout-value"/>

The default timeout value is 10800000 (in milliseconds, which is 3 hours). You can increase that
value, in milliseconds, as needed.
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How to send comments about documentation and
receive update notifications
You can help us to improve the quality of our documentation by sending us your feedback. You can
receive automatic notification when production-level (GA/FCS) documentation is initially released or
important changes are made to existing production-level documents.
If you have suggestions for improving this document, send us your comments by email.

doccomments@netapp.com
To help us direct your comments to the correct division, include in the subject line the product name,
version, and operating system.
If you want to be notified automatically when production-level documentation is released or
important changes are made to existing production-level documents, follow Twitter account
@NetAppDoc.
You can also contact us in the following ways:
•

NetApp, Inc., 1395 Crossman Ave., Sunnyvale, CA 94089 U.S.

•

Telephone: +1 (408) 822-6000

•

Fax: +1 (408) 822-4501

•

Support telephone: +1 (888) 463-8277
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